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Product Warranty Statement

ELECTRONZ LTD - LIMITED LIFETIME WARRANTY

All Engine Control Units (ECUs) manufactured or distributed by Electronz Ltd are subject to the
following LIMITED LIFETIME WARRANTIES, and no others.

Electronz Ltd warrants only to the original purchaser of the ECU, for the lifetime of the ECU, (subject to
the limitations set out below), that the ECU shall be free from defects of materials and workmanship in the
manufacturing process. This warranty ceases to apply and does not apply to ECUs that have not been
manufactured or distributed by Electronz Ltd for a period of greater than one year.

An ECU claimed to be defective must be returned to the place of purchase. Electronz Ltd, at its sole option,
may replace the defective ECU with a comparable new ECU or repair the defective ECU.

This limited lifetime warranty is not transferrable and does not apply to any ECU not properly installed or
properly used by the purchaser or end user, or to any ECU damaged or impaired by external forces. The
above warranties are the full extent of the warranties available on the ECU. Electronz Ltd has no liability to
the original purchaser or any other person for any loss, injury or damage to persons or property resulting
from the use of the ECU or any failure of or defect in the ECU whether by general, special, direct, indirect,
incidental, consequential, exemplary, punitive, or any other damages of any kind or nature whatsoever.
Electronz Ltd specifically disclaims and disavows all other warranties, express or implied, including, without
limitation, all warranties of fitness for a particular purpose, warranties of description, warranties of
merchantability, trade usage or warranties of trade usage.

For off-road use only, not intended for highway vehicles. This ECU contains a user-configurable software
programme, which is updated by Electronz Ltd from time to time. The user must ensure the current correct
version of this programme is downloaded from the website of Electronz Ltd and installed in the ECU prior
to use. This limited lifetime warranty does not apply where the ECU has been installed with the incorrect
version of the software programme. The user is solely responsible for the setup and testing of all
user-configurable features.

Electronz Ltd License Agreement

The software programme in this ECU is licensed not sold. Electronz Ltd grants the user a license for the
programme only in the country where the programme was acquired. No other rights are granted under
this license and the programme may only be used on one machine at a time. If the

programme is transferred a copy of this license and all other documentation must be transferred at the
same time. The license may be terminated by the user at any time. Electronz Ltd may terminate the licence
if the user fails to comply with the terms and conditions of this license. In either event the copy of the
programme must be destroyed.
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1 Introduction

Thank you for purchasing your Vi-PEC Plug-In Engine Control Unit (ECU). Vi-PEC i-Series ECUs are an
advanced, fully programmable microprocessor controlled Engine Management System.

The i-Series software platform boasts an impressive list of features giving a new level of user adjustment.
This flexibility allows the tuner to have complete control over the engine management system. i-Series
software employs high resolution fuel and ignition tables with configurable load and RPM centres. When
coupled with up to six dimensional fuel and ignition mapping, barometric pressure compensation and
intake air temperature correction this gives an unprecedented level of tuning accuracy. All Vi-PEC i-
Series ECUs are in field upgradeable, there is no need to return the unit for software updates.

All Vi-PEC i-Series Plug-In Engine Management Systems are designed with flexibility and ease of
installation in mind. Vi-PEC Plug-In systems are designed to either replace the circuit board inside the
factory ECU enclosure, or entirely replace the factory ECU. This provides an invisible install that
requires minimal modification to vehicle wiring and ECU mounting.

Vi-PEC Engine Management Systems are designed with the final result in mind. Not only do they boast
an impressive range of performance features, but are designed with a focus on safety, reliability and
drive-ability. However, the ultimate success of your engine management upgrade is determined by how
well the system is installed and tuned.

Installing and tuning any after market engine management system is not to be taken lightly. i-Series
ECUs give the tuner the control & flexibility that only top after-market engine management systems in
the world can provide. While every effort has been made to keep i-Series ECUs as user friendly as
possible, it should be recognised that added features bring added complexity.

The complete setup of your ECU can be divided into two important tasks:

1. This manual covers the installation of your i-Series ECU. While it is not strictly essential that this
work is performed by an automotive electrician, the knowledge and tools available to these
professionals makes it highly recommended. Regardless of who does the installation, it is of utmost
importance that instructions provided in this manual are followed exactly throughout the installation.

2. Once the i-Series ECU has been installed it will need to be tuned using a laptop computer with iVTS
software. Information on the configuration and tuning of the i-Series ECU is detailed in the online help
section of iVTS. i-Series ECUs are shipped pre-loaded with a base configuration that should be close
enough to get most engines running after a few application specific adjustments have been made.
While hearing the engine running on the new ECU for the first time is always a satisfying feeling, it is
important to realise that the job is not complete. The amount of tuning performed and the experience
of the tuner are the two most important factors in determining how happy you will be with your engine
management system.

1.1  Safety Notice

Your Vi-PEC Plug-In ECU is designed to enhance the performance of your vehicle. However in all
cases, your vehicle must be operated in a safe manner. Do not tune your vehicle while operating it on
public roads. Obey road rules at all times.

WARNING!

Failure to follow all installation and operating instructions may result in
damage to the Vi-PEC ECU, personal injury, or harm to property.

1.2 Disclaimer

All care has been taken to ensure the pin outs and interconnections of the ECU to the vehicles wiring
harness are correct. However due to variations between vehicle models it is the installers responsibility
to check wiring connections BEFORE installing the ECU. Vi-PEC will not be held responsible for any
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1.3

damage caused by the incorrect installation of this product.

Support Options

Should any issues arise during installation, the following options exist for technical support:
1. iVTS help, press F1 while running iVTS

2. Contact your nearest Vi-PEC dealer. A Vi-PEC dealer list is available on our website.

3. Vi-PEC website: www.\i-pec.com

4. Technical Support Email: support@vi-pec.com

5. Online Discussion Forum: Available from the Vi-PEC website.

The majority of questions received by the technical support team are clearly answered in the manuals.
To speed up your technical inquiry please consult the manuals to make sure that your question has not
already been answered.

© 2014 Vi-PEC
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2 Installation

This guide provides information on correctly and safely installing your new Vi-PEC i-Series Plug-In ECU.

2.1 ECUHandling Procedures

WARNING!!

The following installation process will require handling of both the Vi-PEC ECU
and factory ECU. Both of these are highly sensitive to electrostatic discharge
and are easily damaged. Follow the anti-static precautions given in this
manual carefully to awid damaging electronic components. Warranty claims
for ECUs damaged by electrostatic discharge will NOT be accepted.

ANTI-STATIC HANDLING GUIDELINES

A
Aiad

Your body builds up an electrical charge as you mowe around. This charge can reach very
high wltages. Whenever given the opportunity this energy will attempt to discharge
(usually through your finger tips!). This can be fatal to most electronic components. Most
people have experienced an electrostatic discharge when they step out of their car or
touch a metal bench top.

1. The following guidelines describe precautions that can be taken to reduce the possibility

of damaging your ECU:
2. Work only on a conductive surface. A clean steel bench is suitable.
3. Always wear a wrist strap that is electrically connected to the conductive working
surface.
4. Touch the working surface regularly.
5. Do NOT touch components on the circuit board.
6. Where possible, only handle the ECU by its plastic header.
7. Do NOT carry the ECU around without anti-static packaging.
8. Do NOT touch the bare terminals in the ECU header.
Obsenving the above procedures will minimise the chance of damaging the ECU. Note that
failure due to static damage often does not appear until well after it was caused.

2.2  Fitting the ECU

Information is provided to assist in fitting the ECU into the vehicle.

2.2.1 Fitting a Toyota ECU

The following steps outline the installation procedure:

1. Remowe the factory ECU from the wehicle: Ensure the key is in the OFF position. The factory ECU is
located:

e Celica - in the centre of the vehicle under the dash
e Supra - under the passenger foot panel
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e MR2 - in the boot attached to the firewall

Unplug the wiring harness from the factory ECU. Remowe the bolts that retain the ECU mounting
structure and remove the ECU from the vehicle. DO NOT touch the exposed pins in the factory ECU
connector.

2. Remowe the factory ECUs circuit board from its enclosure: Ensure you are following the given anti-
static guidelines and ARE WEARING A CONDUCTIVE WRIST STRAP connected to a conductive
working surface. Remowe the top cover by removing the side retaining screws. Remowe the circuit
board by removing the corner screws. Hold it only by the plastic header and place it aside.

3. Modify the case if required: It may be necessary to cut the centre bar out of the enclosure using the
appropriate tool. This will be necessary if the centre bar interferes with the ECU.

4. Connect the ECU USB tuning cable and the expansion loom to the Vi-PEC Plug-In ECU if required.

5. Fit the Vi-PEC Plug-In ECU: Place the Vi-PEC ECU on the base plate and carefully fit the four corner
screws. Place the factory ECU in the packaging your Vi-PEC ECU came in for its protection.

6. Refit the top cover: It may be necessary to widen the slot around the main header to allow cables to
exit. Ensure that any modifications are de-burred to prevent cutting into cable insulation.

7. Reassemble the enclosure and fit the ECU back to the wehicle.
8. Connect the ECU to the factory wiring loom.

9. Do NOT attempt to start the vehicle. Proceed to read through the remaining sections of this manual
first.

Note: The bolt that holds the Toyota Supra header plug in place will screw right through all the thread
and spin. This is normal.

© 2014 Vi-PEC
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3.1

3.1.1

3.2

3.2.1

3.3

33.1

Additional Sensors

i-Series Plug-In ECUs offer various options for the installation of additional sensors and devices. As a
minimum it is recommended that all ECUs are installed with a Manifold Absolute Pressure (MAP)
sensor and Intake Air Temperature (IAT) sensor. These parts can be purchased if required from your
nearest Vi-PEC dealer.

MAP Sensor

It is important that the pressure source for a MAP sensor be taken from a stable pressure source after
the throttle body. It is common to T into the fuel pressure regulators pressure signal. Do NOT share
this signal with other devices such as boost gauges or blow off valves.

Toyota Supra 92 to 97

The Vi-PEC i-Series Toyota Supra Mk4 Plug-In ECU supports several options for fitting of a MAP sensor.
Any one of the following options can be used:

1. Factory MAP Sensor. The factory MAP sensor is wired to AnVolt1.

2. MAP Through Expansion Connector - The expansion connector provides power, ground, and analog
channels for the connection of a MAP sensor.

Make sure that the correct An Volt channel has been selected as MAP sensor in iVTS and a MAP
calibration has been performed before attempting to start the vehicle.

IAT Sensor

It is highly recommended that an IAT sensor be fitted in all applications to provide an input for correction
of fuel and ignition based on the engines air charge temperature.

An IAT sensor should be fitted in the intake system in a location that accurately represents intake
temperature. The most common location is just prior to the throttle body. Installing in the manifold is
not recommended due to heat soak issues. A fast response sensor must be used in all forced induction
applications.

Toyota Supra 92 to 97

From factory, the Toyota Supra MK4 has a factory IAT sensor wired to AnTemp 2.

Expansion Connector

The expansion connector is provided to allow easy connection of additional ECU inputs. An “expansion
cable” needs to be purchased from your Vi-PEC dealer.

Important points when wiring to the expansion connector:

¢ Do not owerload the +5V Out pin. Although this is protected against ECU damage the +5V out signal
also provides power for other sensors.

¢ Do not connect the ground pin to chassis ground. This could cause ground loops and introduce
unnecessary interference. Use this pin only to ground external sensors that are isolated from chassis
ground.

Toyota Supra 92 to 97

The following expansion connector inputs/outputs are provided:

GND Sensor Ground Only

© 2014 Vi-PEC
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+5V Low Current +5V Supply
An Volt 7 Analog 0-5V input
An Volt 6 Analog 0-5V input
An Temp 4 Temperature sensor input
An Temp 3 Temperature sensor input
DI 8 Digital Input
DI 7 Digital Input
GND
+5V
Volt 7
Volt 6
Temp 4
Temp 3
DI 8
DI 7

© 2014 Vi-PEC



PC Tuning 11

4 PC Tuning

i-Series ECUs require PC/laptop tuning using the iVTS Tuning Software application running on a
Windows based computer. iVTS may be downloaded from www.\i-pec.com. Note that when new
versions of iVTS are released they are posted on the website and may be downloaded at no cost. Also
note that i-Series ECUs must be used with the correct version of iVTS.

IMPORTANT!
The i-Series ECU has on board USB.

BEFORE connecting the ECU to your laptop, the USB drivers must be
installed. Failure to install the drivers on your laptop first may result in
windows assigning incorrect drivers. These drivers will not work with the i-
Series ECU and are difficult to uninstall. The correct USB drivers are installed
as part of iVTS installation, as described in the following section. Should
internet download not be practical, a copy of the drivers on CD can be
obtained from your nearest Vi-PEC dealer.

4.1 Installing iVTS

Due to the frequent updates iVTS is no longer shipped with each ECU. You will be required to download
the latest version of iVTS from: www.\i-pec.com

Should access to an Internet connection be impractical, the latest version of iVTS can be requested from
your nearest Vi-PEC dealer on CD.

Installing from the web

1. Go to the abowe website and navigate to the downloads and software updates section.

2. Download the latest version of iVTS. When prompted to run or sawe the file, select sawe. It is
recommended to sawe this file on the desktop.

. Double click the saved file and follow on screen instructions.

. When prompted to install USB drivers, select yes. This may take some time.

. When installed, open iVTS by double clicking on the icon that has been placed on the desktop.
stalling from a CD

In
1. Insert the iVTS disk into you computer's CD ROM drive.

2. Open 'My Computer'

3. Double click your CD ROM drive.

4. Double click the file labelled iVTSSetup.exe (or similar name).
5

6

7

g~ w

. Follow the on screen instructions.
- When prompted to install USB drivers, select yes. This may take some time.
. When installed, open iVTS by double clicking on the icon that has been placed on the desktop.

4.2 Communicating With Your ECU

After iVTS installation, you will be able to connect the i-Series ECU to the laptop to perform set-up and
tuning work.

1. Connect the ECU to your laptop using a Vi-PEC i-Series ECU USB Cable. If not supplied with the
ECU, these can be purchased from a Vi-PEC dealer. No other adapter or cabling is required.
Connect the cable to the connector labelled USB.

2. If this is the first time you have connected a i-Series USB ECU to your laptop follow the driver
installation instructions that appear. When prompted if you want to install drivers select ‘Continue
Anyway"'.

3. Start iVTS by double clicking on the iVTS icon on the windows desktop.

4. Switch the key to the ON position. This will provide power to the ECU.

5. In iVTS, under the 'Options' menu, select 'Connection’. The connection options dialogue will open.
Select the correct COM Port number from the drop down list or select auto for automatic com port
detection.

6. iVTS offers both mouse and keyboard control. To establish a connection between the PC and ECU

© 2014 Vi-PEC
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press the F3 key. The same process can be used to disconnect. If a successful connection is
established, iVTS will download settings from the ECU, otherwise you will be warned that an error has

occurred.
7. Make sure the connection shows “ONLINE” in the top right corner of iVTS.

8. To permanently STORE any changes made to the ECU press F4. If this is not done before turning

the ECUs power off all changes made will be lost.

© 2014 Vi-PEC
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5.1

5.2

5.3

5.4

Pre-Start Configuration

Before starting the wvehicle, important pre-start configurations need to be made.

Firmware Version

It is recommended that the Vi-PEC i-Series ECU is running the most up to date firmware. Firmware
version information can be obtained by connecting to the ECU with iVTS and selecting 'ECU Information
under the Help menu.

The latest firmware can be downloaded from our website with iVTS.
It is recommended that this is performed by an experienced Vi-PEC dealer as new features may need to
be properly configured.

The firmware can be updated by selecting 'Update Firmware' under the 'ECU Controls' menu in ivVTS.
Follow the on screen instructions to complete the firmware update process.

Base Configuration

All i-Series Plug-In ECUs are shipped with base configuration settings. Note that these are provided to
reduce initial setup and tuning times. They are NOT recommended tuning values. VTS includes base
configurations for various models. Download the appropriate base configuration into your ECU with iVTS
by connecting to the ECU (described in the Connecting To iVTS section of this manual), then selecting
'‘Open’ under the 'File' menu. Select the appropriate .pcl file and then select 'Open’. Downloading large
configuration files can take up to a few minutes. Be patient and acknowledge any messages iVTS
shows.

MAP Sensor Calibration

At key on and engine not running the Manifold Absolute Pressure (MAP) Sensor should always match
the Barometric Absolute Pressure (BAP) Sensor. As well as providing altitude correction, the BAP
sensor also allows the MAP sensor to be calibrated prior to tuning.

Vi-PEC i-Series ECUs use an on-board barometric sensor that is calibrated prior to dispatch. This
ensures that all iVTS Tuning Software programs (pcl Files) give a consistent state of tune throughout the
ECU range. This allows a PCL file to be transferred between i-Series based ECUs giving an equivalent
state of tune providing all factors affecting wvolumetric efficiency are equal.

Without the ability to calibrate all the available types of MAP Sensors to the BAP Sensor there would be
significant affects on the accuracy of the resulting tune, especially when tuning with Manifold Gauge
Pressure (MGP) as a load index.

To calibrate the MAP sensor:
1. Connect a laptop/notebook PC to the ECU and connect to the ECU using iVTS.

2. Under the Analog Channels menu, select the An Volt channel that has been wired to the MAP
sensor. Select the correct MAP Sensor Type.

. Under the 'Options' menu, select 'MAP sensor calibration'.

. Follow the on screen instructions.

. Select the 'Analog Inputs' tab in the runtime values section of iVTS (lower part of the screen).
. Compare the MAP and BAP values and ensure they have a similar reading (within 1 kPa).

N o o bW

. Perform a 'Store' by pressing F4.

TPS Calibration

The Throttle Position Sensor (TPS) is used by the ECU to calculate various engine management
parameters used by functions such as idle speed control,acceleration enrichment and motor sport

© 2014 Vi-PEC
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5.5

5.6

features. It is important that the ECU knows when the throttle is open and closed (or part way in
between). The following procedure calibrates the ECU to match the TPS and is for engines using a cable
driven throttle:

1. Connect a laptop/notebook PC to the ECU and connect to the ECU using iVTS.

2. Under the Analog Channels menu, ensure that the correct An Volt channel is set to 'TPS (Main)'.
Refer to the pin functions section of this manual for details.

. Under the 'Options' menu, select 'TPS calibration'.

. Follow the on screen instructions.

. Select the ‘Analog Inputs' tab in the runtime values section of iVTS (lower part of the screen).

. Ensure the Throttle Position value reads 0% when the throttle is closed and 100% when fully open.

N o o bW

. Perform a 'Store' by pressing F4.

For engine setups that use Electronic Throttle Control the Foot Position Sensor (FPS) and Throttle
Position Sensor (TPS) need to be calibrated.

For Vi-PEC Plug-in ECUs see iVTS Help > i-Series ECU Tuning Functions > Electronic Throttle >
Electronic Throttle Control TPS and FPS Calibration

IAT Sensor Selection

This section only applies when an Intake Air Temperature (IAT) sensor has been wired and fitted to the
intake system. It is important that the ECU is calibrated to match the sensor installed in the engine.
This procedure is as simple as selecting the correct sensor type as follows:

. Connect a laptop/notebook PC to the ECU and connect to the ECU using iVTS.

. Click on 'Analog Channel' in the configuration tree.

. Select the An Temp channel the sensor has been wired to.

. Ensure that channel (and only that channel) is set to ‘Inlet Air Temperature'.

. Select the correct Temp Sensor Type'.

. Select the 'Analog Inputs' tab in the runtime values section of iVTS (lower part of the screen).
. Ensure that IAT reads the correct temperature.

0 N o o0~ WDN P

. Perform a 'Store' by pressing F4.

Input and Output Setup

As the Vi-PEC i-Series Plug-In ECUs are designed to run several models there are a few items that
must be set-up to make the ECU specific to your model.

The Pin Functions section of this manual gives a list of the functions of each channel based on the
target vehicle.

It is the tuners responsibility to make sure that the following channels are set-up correctly for the vehicle
model the ECU is fitted to:

All Auxiliary Output Channels
Use the 'Test On' or Test PWM' (at 10 Hz) functions to test the wiring of channels.
All Digital Inputs

Look at the Digital Inputs runtime values (lower section of the iVTS screen) to confirm each channels
operation.

All Analog Volt and Temperature Inputs
Look at the Analog Inputs runtime values (lower section of the iVTS screen) to confirm each channels

© 2014 Vi-PEC
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operation.

5.7 Trigger Calibration

The following instructions assume that all pre-start set-up instructions given in previous sections have
been completed. Only after all pre-start checks have been made should an attempt be made to crank
the engine. The following steps must be performed before an attempt is made to start the engine to
ensure the i-Series ECU is calibrated to precisely measure engine position.

1. Connect the ECU to iVTS.

2. Select 'Fuel', then 'Fuel Set-up"
a. Set ‘Injection Mode’ to OFF. This will prevent the engine from trying to start while the triggers are
calibrated.
b. Perform a Store (press F4) to make sure fuelling is not re-enabled if power to the ECU is lost.
3. Click on ‘Triggers’ then ‘Calibrate Triggers’.
4. Perform the correct trigger calibration procedure specific to your vehicle as described in the iVTS
online help (Press F1).
Note that trigger calibration must be performed again once the engine is running. Due to the
acceleration and deceleration of the crankshaft at low speeds, an inaccurate measurement of engine
timing is usually made. Also it is often harder to see timing marks with a timing light at slow engine
speeds. Trigger calibration should be checked again at between 2000-4000 RPM where engine speed is
stable and a more consistent timing reading can be obtained.

© 2014 Vi-PEC
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6

6.1

First Time Startup

After performing all set-up instructions given in previous sections, including trigger calibration, the engine
is now ready to be started. The following procedure should be used for first time start-up.

1. Turn the ignition key OFF then ON. The fuel pump should prime momentarily upon power up.
2. Connect the ECU to iVTS.
3. Access the runtimes values by pressing the F12 Key, click the 'Analog' tab:

a. TPS — spans from 0 to 100% when throttle is pressed. If not, perform a TPS Calibration.

b. MAP — should read approx 101 kPa (at sea level) with the engine not running. If not, check the
MAP Sensor Type setting and perform a MAP Calibration.

C. ECT — should read current engine temperature.
d. IAT — should read current intake air temperature.

e. Digital Inputs (click the 'Digital' tab) — Operate switches connected to any digital inputs while
watching the runtime value to ensure they operate as expected.

4. Rectify any faults found in Step 3.

5. Locate the 'Master Fuel' setting. This can be found in the ECU Settings Menu under: Fuel > Fuel
Setup > Fuel Main.

a. This will need to be adjusted during or just after start-up.

6. Crank the engine until it starts. Some throttle may be required for first time start-up due to imperfect
tuning. If necessary adjust the Master setting to enrich/lean the engine (increase to enrich).

7. If the engine fails to start after several attempts, do not crank it endlessly. Stop and determine the
problem before continuing.

8. Check the Trigger Error Counter (found under the Triggers runtime values tab). If this value increases
during cranking/running then there is a trigger setup fault. It is not unusual for this number to count
one or two on the first engine revolution.

9. Once the engine starts, adjust the ‘Master’ (under fuel settings) setting to achieve best possible
running.

10.The engine should now be allowed to fully warm up. It may be necessary to readjust ‘Master’ several
times to maintain smooth running. Don't forget to keep an eye on engine temperature.

11.0nce the engine is warmed up and running well, perform another trigger calibration (known “as setting
the base timing”).

12.Perform a Store by pressing F4.

Final Checks

To awoid potential engine damage and wasted time, the adjustments presented in the following sections
must be made before attempting to start the engine.

For further help on any of the settings discussed below, consult the online Help in the iVTS Tuning
Software. Online help can be invoked by pressing F1, or right clicking any item and selecting ‘What’s
this?'.

Pre-set-up Checks

Before attempting to configure the ECU, ensure the following tasks have been completed:

1. Ensure the ECU and all associated components are connected and correctly wired/installed.

2. Fully charge the vehicle’s battery, as the engine will be required to be cranked during the set-up
procedure.

3. Check all oil and water lewels are correct.

Connecting to iVTS Tuning Software

Use the following procedure to establish a connection between your Vi-PEC ECU and iVTS Tuning
Software tuning software.

© 2014 Vi-PEC
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6.2

1. Make sure your laptop battery is fully charged or plugged in to mains power.
2. Connect the ECU to your laptop and connect to iVTS Tuning Software as described in the
‘Communicating with your ECU' section of this manual.

Essential Tuning Adjustments

It is assumed that at this stage all set-up procedures described in previous sections have been
completed and the engine is running. The following steps detail correct set-up procedures for some of
the more critical ECU parameters (note that MAP Sensor Calibration should have already been
completed by now):

Injector Voltage (Dead-time) Correction

There is always a delay between the injector being energised and the injector actually opening.
Likewise, there is a small delay between the injector being de-energised and the injector closing. The
opening time is considerably longer than the closing time, however the overall result is that less fuel will
flow for a given pulse width than would be expected with an ‘ideal injector'. To compensate for this the
injector pulse widths are increased to compensate for this ‘dead-time’. The dead-time for a given injector
is a function of the battery wltage, differential fuel pressure and the type of injector driver (saturated or
peak and hold). A typical dead-time at 3 Bar differential fuel pressure and 14 wolts is just under 1ms (ms
= millisecond = 1 thousandth of a second).

In applications with a linear 1:1 fuel pressure regulator (i.e. not a rising rate regulator), the differential fuel
pressure (difference between manifold pressure and fuel pressure) will be constant. Therefore the only
variable that is changing will be the battery woltage (this changes with electrical load and sometimes
engine speed). Without correction, the changes in dead-time will cause the engine to run lean when the
wltage drops. If the Injector Voltage Correction is properly set-up then changes in the battery voltage
will not affect the air/fuel ratio.

The injector dead-time table allows the dead-time for different battery woltages to be entered. The values
represent the dead-time in milliseconds. These should increase with falling system woltage.

Injector dead-time for a particular set of injectors can be determined using a flow bench or on a running
engine.

To determine the injector dead-time using a flow bench, the injectors need to be operated at the intended
operating pressure (normally three bar) and at a constant duty cycle as well as a set wltage. Vary the
supply woltage to the injector and measure minimum pulse width at which the injectors will flow for a
particular wltage. This is the required dead-time for that injector at that tested woltage.

To determine injector dead-time on a running engine, with the engine fully warmed and operating at
stable air/fuel ratios (a very precise AFR meter is required — a narrow band O2 sensor will not suffice),
electrical drain needs to be applied to the system; the preferred method is disconnecting the alternator
main fuse. Battery load testers are also useful here too.

Watching the air fuel ratios change while the battery wvoltage drops, the dead-time table can be trimmed
to maintain the same stable air/fuel ratio. Injector dead-time can be viewed as a row graph. A smooth
curve needs to be maintained at all times.

NOTE: any change to the fuel pressure or injectors will require a recalibration of the injector dead-times.
Master

Master should be set so that the numbers in the middle of the fuel table end up around a value of 50.
This is to allow sufficient span of the numbers in the main fuel table.
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7 Pin Functions

A list of pin functions is provided, this is useful when configuring your ECU through iVTS.

7.1

Toyota Supra 92 to 97

|93 to 98 2JZ-GTE Toyota Supra

Auxiliary Outputs

Aux 1 Tacho

Aux 2 Fuel Pump speed control
Aux 3 A/C Clutch relay

Aux 4 Wastegate Solenoid
Aux 5 Idle Stepper 1

Aux 6 Idle Stepper 3

Aux 7 Idle Stepper 2

Aux 8 Idle Stepper 4

Aux 10 Purge Solenoid

Aux - Injection Outputs

Aux Inj7

02 Heater

Aux Inj 8

ECU Hold pow er

Aux — Ignition Outputs

Aux -lgn7

Check Engine light

Aux -Ign 8

Fuel Pressure Increase Solenoid

Analog Channels

An Volt 1 MAP Sensor

An Volt 2 Air Mass Meter Signal (AFM)
An Volt 3 NB Oxy

An Volt 4 NB Oxy

AnVolt 5 Throttle Position Sensor
An Volt 6 Expansion connector
An Volt 7 Expansion connector
An Volt 8 Oxygen Sensor Signal
An Temp 1 ECT Signal

An Temp 2 IAT Signal

An Temp 3 Expansion connector
An Temp 4 Expansion connector
Digital Inputs

DI1 Vehicle Speed Signal
DI 2 Ignition Switch

DI3 A/C Request

Dl 4 Electrical Load Sensor
DI 5 Start Signal

DI 6 Brake Switch

DI 7 Expansion connector
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DI 8

Expansion connector
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8.1

Pinouts

Pin information is provided to assist when troubleshooting. All pinouts are looking into the ECU (wire

side).

Toyota Supra 92 to 97

ECM Terminals
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Pin ECU Function Pin ECU Function
Al DI 2 B43 An Volt 5
A2 DI 1 B44 An Temp 1
A4 DI 6 B45 An Temp 2
A6 Ign 7 B47 An Volt 4
A15 DI 4 B48 An Volt 3
A16 Aux 1 B49 Knock 2
A22 Aux 2 B50 Knock 1
A23 Aux 3 B52 Ign 6
A34 DI 3 B53 Ign 5
B15 Inj 6 B54 Ign 4
B16 Inj 5 B55 Ign 3
B17 Inj 4 B56 Ign 2
B18 Inj 3 B57 Ign 1
B19 Inj 2 B60 Aux 4
B20 Inj 1 B62 An Volt 1
B25 Trig 2 B65 Sensor GND
B27 Trig 1 B66 An Volt 2
B32 Aux 8 B71 Inj 7
B33 Aux 6 B72 Inj 7
B34 Aux 7 B73 Ign 8
B35 Aux 5 B74 Aux 10
B41 +5 Volt out B76 DIS
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9 Known Issues

All plug-in ECUs are fully tested on a range of relevant vehicles, although there are often variations that
have not been tested. For this reason issues can arise.

WARNING: Always download the latest Installation Manual from vi-pec.com and check the latest status
of known issues before installing the ECU.

Please contact your nearest Vi-PEC dealer when suspecting a compatibility issue.

9.1 Toyota Supra92to 97

There are currently no known issues.
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